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InDesign Project Guide

Create a new document under the File menu. In the
New Document box, make sure Facing Pages is
checked on, and enter the number of pages for the
project. Remember that there have to be an even
number of pages.

You can set the page size here, as well as the
number of columns and the margin measures.

If you want to change the columns and margins
after you've created the document, double-click

on the Master Pages to select them, then go to the
Layout menu and select Margins and Columns...

Choose your typefaces for headlines, subheads and
body text. Be consistent throughout the publica-
tion: Use the same typeface, size and leading for
the same elements on all pages.

Common mistakes
Inappropriate specialty typeface.

« Avoid specialty typefaces such as Comic Sans or
Papyrus. Look at examples in the font pages folder
in the handouts folder.

« Choose point and leading sizes, don't use de-
faults. The wider the column, the more leading is
needed, but avoid wide columns.

- Control kerning in the headlines, tracking in the
text blocks. Use tracking to expand or contract text
blocks to fit, but not more than 30 em.

«In general, avoid Align Center for text blocks, it’s
harder to read. Also, avoid using all caps in text
blocks.

« Turn off hyphenation for headlines and short text
blocks. Uncheck it in the Paragraph panel.

« Avoid having text bump up against images or
frames.

Black text on a dark background. Change
the text color to white.
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Torem ipsum dolor sit amet, consectetuer ?
hdipiscing elit. Aenean commodo ligula eget dojor.
JAenean massa. Cum sociis natoque penatibus ef
Inagnis dis parturient montes, nascetur ridicul
nus. Donec quam felis, ultricies nec, pellentesqfie
bu, pretium quis, sem. Nulla consequat massa qis
bnim. Donec pede justo, fringilla vel, aliquet ned,
ulputate eget, arcu. In enim justo, rhoncus ut,
mperdiet a, venenatis vitae, justo. Nullam dictm
elis eu pede mollis pretium. Integer tincidunt.
[Cras dapibus.

Subhead
Vivamus elementum semper nisi. Aenean
ulputate eleifend tellus. Aenean leo ligula,
orttitor eu, consequat vitae, eleifend ac, enim.
JAliquam lorem ante, dapibus in, viverra quis,
eugiat a, tellus. Phasellus viverra nulla ut metus
arius laoreet. Quisque rutrum. Aenean imperdet.
[Etiam ultricies nisi vel augue.

Lorem ipsum dolor sit amet, consectetuer
hdipiscing elit. Aenean commodo ligula eget dojor.
JAenean massa. Cum sociis natoque penatibus ef
Inagnis dis parturient montes, nascetur ridicul
Inus. Donec quam felis.

Lorem ipsum dolor sit amet, consectetuer
hdipiscing elit. Aenean commodo ligula eget dojor.
JAenean massa. Cum sociis natoque penatibus ef
Inagnis dis parturient montes, nascetur ridicul
nus. Donec quam felis, ultricies nec, pellentesqfie
bu, pretium quis, sem. Nulla consequat massa qis
bnim. Donec pede justo, fringilla vel, aliquet ned,
ulputate eget, arcu. In enim justo, rhoncus ut,
mperdiet a, venenatis vitae, justo. Nullam dictm
elis eu pede mollis pretium. Integer tincidunt.

[Cras dapibus.

sum dolor sit amet, consectetuer]
i odo ligula
Cum sociis
gnis dis parturient
Imontes, nascetur ridiculus mus. Donec
lquam felis, ultricies nec, pellentesque eu,
[pretium quis, sem. Nulla consequat massa
lquis enim. Donec pede justo, fringilla vel,
laliquet nec, vulputate eget, arcu. In enim
justo, thoncus ut, imperdiet a, venenatis
lvitae, justo. Nullam dictum felis eu pede
Imollis pretium. Integer tincidunt. Cras
ldapibus.

%

Lorem ipsum dolor sit amet,
consectetuer adipiscing elit.
|Aenean commodo ligula eget
dolor. Aenean massa. Cum sofiis
natoque penatibus et magnis
dis parturient montes, nascetur
ridiculus mus. Donec quam
felis, ultricies nec, pellentesque
leu, pretium quis, sem. Nulla
consequat massa quis enim.
IDonec pede justo, fringilla vel,
aliquet nec, vulputate eget,
jarcu. In enim justo, rhoncus ut,
imperdiet a, venenatis vitae,
justo. Nullam dictum felis eu
ipede mollis pretium. Integer
tincidunt. Cras dapibus.

dapibus in, viverra quis,
feugiat a, tellus. Phasellus
viverra nulla ut metus varius
laoreet. Quisque rutrum.
|Aenean imperdiet. Etiam
ultricies nisi vel augue.
Lorem ipsum dolor sit amet,
consectetuer adipiscing elit.
|Aenean commodo ligula eget
dolor. Aenean massa. Cum
sociis natoque penatibus et
Imagnis dis parturient montef,
nascetur ridiculus mus. Donec|
quam felis.
Lorem ipsum dolor sit amet,
consectetuer adipiscing elit.
|Aenean commodo ligula eget
dolor. Aenean massa. Cum
sociis natoque penatibus et
Imagnis dis parturient montef,

Subhead
Vivamus elementum semper
nisi. Aenean vulputate eleifend

/' : “ Inascetur ridiculus mus.
tellus. Aenean lgo llgulé, porttitonnonec quam felis, ultricies Overset
leu, consequat vitae, eleifend nec, pellentesque eu, pretiun
ac, ST, ANqUarm IGTEmT ante, Juis, sem. Nulla consequat  [f] €— text.
N

|

Inconsistent

Text blocks are

Text blocks outside of

bumping up against
other elements.

type sizes and
leading.

column guides.

Photo scaled unevenly.

Provide some buffer.
Column gutters are
too narrow.

i |% 33.72060. 3 | ... (lick on photo with white arrow. These two

;¢ numbers should be the same. Uncheck the

< chain symbol to change them.
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Example

Page size: 48p x 36p (8" x 6”)
12 facing pages

Margins: 3p0 on all sides
Columns: 2
Gutter: 2p0

Fonts:

Cover: Monotype Corsiva regular 90/120
Headline: Myriad Pro black 40/54
Subhead: Myriad Pro bold 14/18

Bodly text: Palatino regular 12/18
Cutline: Myriad Pro condensed 12/16
Credit: Myriad Pro regular 8/10

Hokkaido’s Gem

Lotem ipsum dolor sit amet, consectetuer|  sem. Nulla consequat massa quis enim.

adipiscing elit. Aenean commodo ligula eget
dolor. Aenean massa. Cum sociis natoque
penatibus et magnis dis parturient montes,
hascetur ridiculus mus. Donec quam felis,

ltricies nec, pellentesque eu, pretium quis,

Denec pede justo, fringilla vel, aliquet nec,
wulputate eget, arcu. In enim justo, thoncus
t, imperdiet a, venenatis vitae, justo.
fullam dictum felis eu pede mollis pretium.
Integer tincidunt. Cras dapibus.

»

50 miles.

Cutline: Thi blockof Xt explainssomething about the photo, and why [ relates o the story. |

ubhead
Vivamus elementum semper nisi. Aenean|

wulputate eleifend tellus. Aenean leo ligula,

porttitor eu, consequat vitae, eleifend ac,

(Quisque rutrum. Aenean imperdict. Etiam
hultricies nisi vel augue.

Lorem ipsum dolor sit amet, consectetuer
hdipiscing elit. Aenean commodo ligula eget
enim. Aliquam lorem ante, dapibus in, Holor. Aenean massa. Cum sociis natoque
penatibus et magnis dis parturient montes,
hascetur ridiculus mus. Donec quam felis.

Viversa quis, feugiat a, tellus. Phasellus
viverra nulla ut metus varius laoreet.

Monbetsu

Japan 3
i

Subhead
Lorem ipsum dolor sit amet, consectetuer
adipiscing elit. Aenean commodo ligula eget
dolor. Aenean massa. Cum sociis natoque
penatibus et magnis dis parturient montes,
nascetur ridiculus mus. Donec quam felis,
ultricies nec, pellentesque eu, pretium quis,
sem. Nulla consequat massa quis enim.
Donec pede justo, fringilla vel, aliquet nec,

vulputate eget, arcu. In enim justo, thoncus
ut, imperdiet a, venenatis vitae, justo.
Nullam dictum felis eu pede mollis pretium.
Integer tincidunt. Cras dapibus. Vivamus
elementum semper nisi. Aenean vulputate
cleifend tellus. Aenean leo ligula, porttitor
eu, consequat vitae, eleifend ac, enim.
Aliquam lorem ante, dapibus in, viverra

dolor. Aenean massa. Cum sociis natoque
penatibus et magnis dis parturient montes,
nascetur ridiculus mus. Donec quam felis,
ultricies nec, pellentesque eu, pretium quis,
sem. Nulla consequat massa quis enim.
Donec pede justo, fringilla vel, aliquet nec,
vulputate eget, arcu. In enim justo, thoncus
ut, imperdiet a, venenatis vitae, justo.
Nullam dictum felis eu pede mollis pretium.

Creait ne
quis, feugiat a, tellus. Phasellus viverra nulla
ut metus varius laoreet. Quisque rutrum.
Aenean imperdiet, Etiam ultricies nisi vel

augue.

Subhead
Lorem ipsum dolor sit amet, consectetuer
adipiscing elit. Aenean commodo ligula eget

Monbetsu

Japan 5
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Cutline: This lock oftext explains something about the photo, and why it relates o the story.

Subhead Donec pedejusto, fringilla vel, aliquet nec, Subhead dolor. Aenean massa. Cum sociis natoque
Lorem ipsum dolor sit amet, consectetuer o tate eget, arcu. In enim fusto, shoncus Aliquam lorem ante, dapibus in, viverra penatibus et magnis dis parturient montes,
adipiscing elit. Aenean commodo ligula eget .y iunper i a, venenati vitae, justo. quis, feugiat a, tellus. Phasellus viverranulla  nascetur ridiculus mus. Donec quam felis,
dolor. Aenean massa. Cum sodiis natoque Nullam dietum felis eu pede mollis pretium. ut metus varius laoreet. Quisque rutrum. ultricies nec, pellentesque eu, pretium quis,
penatibus et magnis dis parturient montes, e e Aenean imperdiet. Etiam ultricies nisi vel sem. Nulla consequat massa quis enim.
nascetur ridiculus mus. Donec quam felis, i e e augue. Donec pede justo, fringilla vel, aliquet nec,
ultricies nec, pellentesque eu, pretium quis, eleifend tellus. Aenean leo ligula, porttitor Lorem ipsum dolor sit amet, consectetuer  vulputate eget, arcu. In enim justo, thoncus
sem. Nulla consequat massa quis enim. eu, consequat vitae, eleifend ac, enim. adipiscing elit. Aenean commodo ligula eget ut, imperdiet a, venenatis vitae, justo.
Cutline: This block Cutline: This text
of text explains explains something about
something about the the photo, and why it
photo, and why it relates to the story.
relates to the story.
8 Monbetsu | Japan 9
Subhead §  Subhead dolor. Aenean massa. Cum sociis natoque
Lorem ipsum dolor sit amet, consectetuer E Aliquam lorem ante, dapibus in, viverra penatibus et magnis dis parturient montes,
adipiscing elit. Aenean commodo ligula eget quis, feugiat a, tellus, Phasellus viverranulla  nascetur ridiculus mus. Donec quam felis,
dolor. Aenean massa. Cum sociis natoque ut metus varius laoreet, Quisque rutrum. ultricies nec, pellentesque eu, pretium quis,
Aenean imperdiet. Etiam ultricies nisi vel sem. Nulla consequat massa quis enim.

penatibus et magnis dis parturient montes,
nascetur ridiculus mus. Donec quam felis,
ultricies nec, pellentesque eu, pretium quis,
sem. Nulla consequat massa quis enim.
Donec pede justo, fringilla vel, aliquet nec,

augue. Donec pede justo, fringilla vel, aliquet nec,
Lorem ipsum dolor sit amet, consectetuer  vulputate eget, arcu. In enim justo, thoneus

adipiscing elit. Aenean commodo ligula eget  ut, imperdiet a, venenatis vitae, justo.

Cutline: This block of text explains something about the photo, and why it relates to the story.

Cutline: This lock oftext explains something about the photo.

vulputate eget, arcu. In enim justo, thoncus
ut, imperdiet a, venenatis vitae, justo.
Nullam dictum felis eu pede mollis pretium.
Integer tincidunt. Cras dapibus, Vivamus
elementum semper nisi. Aenean vulputate
eleifend tellus. Aenean leo ligula, porttitor
eu, consequat vitae, eleifend ac, enim.

Monbetsu

Creditline.

Monbetsu




VCOM 2950 Visual Communication Applications

Philip Loubere

Working with photos

Download your photos and keep them in a folder
in your project folder. Make a note of site and
photographer name if available, for credit.

Place your downloaded photos, unaltered, on your
pages, and size and crop them as needed. Scale
images proportionally!

Image frame ———

Image ——»

When you're satisfied with your publication design,
and photos are in the size and position you want
them, prepare them for publication:

» Click on the photo with the white arrow tool. In
the control bar at the top, make a note of the photo
dimensions (the image itself, not the frame, if the
image is cropped).

+ Open the photo in Photoshop. Go to Image Size,
and resize the image to the correct dimensions, and
at an appropriate resolution for print (170-300 ppi).
Change the mode to CMYK, and save it as a TIF
(save it to your images folder in your project folder).

« In InDesign, click on the image again. Go to the
Links panel; the image should be highlighted.
Click on the Relink icon at the bottom of the panel,
and choose the TIF version, which will replace the
downloaded version.

* Don't convert your lllustrator map to a TIF. Place
the lllustrator document directly in your InDesign
document. It’s already CMYK (or should be).

W: -3 30p0.729
H: |5 16p9.323

Image dimensions

LINKS

Name |_L | D A|

M monbetsu..._blue.ai
== mountains...wers.tif
B maxresdefault_tif
B flowers2.tif

m flowers 3.tif

= flowers4.tif

B downtownl tif

8 downtown 2 tif

B3 mountain_tif

i tree_landscape.tif

B8 pl010469n.jpg

= =
L= =T - [T - T - - T [ O LEE R | %)

[

Relink button
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Keep in mind

Use Master Pages to create elements that show
up on every page, such as page numbering. You
can also set margins and columns here so that they
apply to the entire document.

Scale images proportionally: Hold down the Shift
key when resizing a frame or image. Choose Fill or
Fit Proportionally from the Fitting options under
the Object menu.

Credit photos. Add a source line underneath

or running vertically along the side, 6-8 points.
Provide at minimum the name of the site where the
image was found.

Create a publication package. This is what

you need to turn in. Use the Package command
under the File menu. Correct any warnings before
proceeding.

Preflight warning (lower left corner of window)

fiisx TG

-

+ kF H @ 1error

-

b

Publication package warning

Summary Summary

Package

Fonts

Links and Images Scope:
Colars and Inks
Print Sattings

External Plug-ins

External

Entire Publication

Fonts: 8 Fonts Used, 0 Missing, 0 Embedded, O Incomplete
0 Protected

Links and Images: 11 Links Found; 0 Medified, 0 Missing. 0 Inaccessible
Images: 0 Embedded, 11 use RGE color space

Colors and Inks: 4 Process Inks; O Spot Inks
CMS is ON

| Plug-ins : 0

Non Opaque Objects :0n Pagel, 2, 3, 4
Number of Documents :1
Pagination Options : None

+| Show Data For Hidden and Non-Printing Layers

Cancel

Report...




